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Futroduction

Welcome to CharSys! With CharSys (short for AD&D Character System), you can easily create and maintain
characters on disk. Not only is CharSys powerful, it is expandable. Using the Editor (available as a seperate
download), you can alter any of the databases that CharSys uses such as races, classes, spells, equipment, etc.
You can even create your own worlds! For more details download the CharSys Database Manager and begin
creating your own AD&D campaign world!

Now for the legal stuff - This package is provided “AS IS”. The author makes no kind of warranties, expressed
or implied, at all regarding any aspect of this package. Data Dimensions Software is in no way affiliated with
Wizards of the Coast, Inc. and Wizards of the Coast™ does not support this package. Data Dimensions
Software™ is in no way trying to infringe on any copyrights owned by Wizards of the Coast™. You must at
least own a copy of the Player’s Handbook to use this package.

This package was written in REALDbasic.
The installer for this product was created using StuffIt InstallerMaker from Aladdin Systems, Inc..

For more information on Stufflt InstallerMaker contact:

Aladdin Systems

165 Westridge Dr.

Watsonville, CA 95076

Voice: 831.761-6200

Fax: 831.761-6209

E-mail: dev.sales@aladdinsys.com
Web: http://www.aladdinsys.com/


http://www.aladdinsys.com/
http://charsys.com/Editors/CSDbM_Installer.bin
http://www.realbasic.com/
mailto:dev.sales@aladdinsys.com
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You can set several preferences as detailed below:

Maximum Hit Points at 15 Level — If checked, then any newly created character will receive maximum hit

points at 15 fevel.

Maximum Money at 15t Level — If checked, then any newly created character will receive maximum money at
15 level.

Use Proficiency Slots for Languages — If checked, then the Edit Languages tool is unelectable and the player
must use the Edit Proficiencies tool to choose languages. If checked, the languages INT bonus will be added to
the non-weapon proficiencies slots.

Enforce Weapons/Armor Restrictions — If checked, then the character will only be able to choose from a list

of weapons, armor, and weapon proficiencies based on his class and/or deity.

Automatically Check for New Versions at Launch - If checked, then CharSys will attempt to connect to the
CharSys Web site to determine the current version of CharSys. If a newer version exists, you will be given the
opportunity to download it.

Show Creation/Input Guide — If checked, CharSys displays a guide that aids users in creating a character. The
guide tells the user what the next step should be after a character has been created.

Show Tips Window — If checked, CharSys will show a Tips Window which gives you tips on how to use
CharSys more efficiently.

Auto-Reposition Toolbar — If checked, the toolbar will position itself just right of the foremost window.



Show Splash Screen — If checked, CharSys will display its splashscreen at launch.

Animate Splash Screen — If checked, CharSys will display its normal, animated splash screen. Otherwise, it
will display static pictures.
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Enforce Class Restrictions - If unchecked, then you will be able to select any alignment no matter what class
is selected.

Enforce Deity Restrictions - If unchecked, then an alignment restrictions pertaining to deity selection will be
ignored.

Enforce Kit Restrictions - If unchecked, then an alignment restrictions pertaining to kit selection will be
ignored.
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Enforce Class Restrictions - If unchecked, then you will be able to select any race no matter what class is
selected,



Enforce Kit Restrictions - If unchecked, then you will be able to select any race no matter what kit is selected.

Enforce Ability Restrictions - If unchecked, then all ability requirements will be ignored.
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Enforce Race Restrictions - If unchecked, then you will be able to select any class no matter what race is
selected,

Enforce Kit Restrictions - If unchecked, then you will be able to select any class no matter what kit is selected.

Enforce Ability Restrictions - If unchecked, then all ability requirements will be ignored.
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Enforce Required Sex Restriction - If unchecked, then the sex requirement will be ignorned.

Enforce Ability Restrictions - If unchecked, then all ability requirements will be ignored.
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Enforce Race Restrictions
selected.

Enforce Class Restrictions
selected.

- If unchecked, then you will be able to select any kit no matter what race is

- If unchecked, then you will be able to select any kit no matter what class is

Enforce Ability Restrictions - If unchecked, then all ability requirements will be ignored.

Enforce Required Sex Restriction - If unchecked, then the required sex restriction will be ignored.
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The Character Sheet tab allows you to arrange your character sheet pretty much how you want it with two
exceptions. General will always be displayed first and notes last. To move a section, select it and then click on
either the Move Up or Move Down buttons.
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Class Sort Order - This allows you to specify how you wish the classes displayed on the Create Character
window. Alphabetical means that all classes will be displayed in alphabetical order. Category means that they
will be displayed alphabetically by category (i.e. Priest, Rogue, Warrior, Wizard) first, then by class.



Eharacter Creation
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The Single-Classed mode is called Normal. In Normal mode you can select an alignment, race, and class. You can
also re-roll as often as you wish. You can also move your ability scores around. See Moving Ability Scores for
information on how to do this. If, for some reason, the class, race, or alignment you wish to select is
unselectable, you can go into Info Mode to find out why.

You will notice you have two options if wish to re-roll. You can roll randomly or you can assign points.

To assign points, just click on the + or - buttons to change their value. Please note that this method of assigning
points does not follow the AD&D 2™ Edition rules exactly.



Beleceing a Kie

o Kit Info/Select Kit [=]
Current class: Fighter
Kits Allowed Races Allowed Alignments
Amazon - Dwarf |~ | Lawful Good g2
Barbarian s EM | | Lawtul Neutral hs
Beast-Rider Gnome Lawful Evil
Berserker Half-elf Neutral Good ‘I
Cavalier Halfling Neutral 5
Gladiator Human Neutral Evil
Myrmidon JJ | | thaotic Good —
Nobel Warrior = | | aotic Neutral E-
M““ =™ A okl
Ability Requirements
You cannot chose this kit for Required Sex fFemale Minimum
the following reasons: STR [ n 0
Your chosen sexis of the DEX | 11 0
wrong gender., yelect CON |12 0
INT 15 0
= ] Cancel | wis | n 0
v CHA |9 0
[&

CharSys now supports kits! Selecting one is very easy. First, select the class you wish your character to be. If
the Select Kit button is enabled then that class has kits associated with it. Click on the Select Kit button and you

will see a window like the one above. All the information should be self-explanitory.

Important - CharSys does not enforce all rules governing kits. The rules that are enforced are:

Bonus NonWeapon Proficiencies
Racial Restrictions

Alignment Restrictions

Ability Score Requirements

Sex Requirement

by el

spending of the slot

Required Weapon Proficiencies (sometimes you will be asked to choose)

Bonus Weapon Slots - Some kits give bonus weapon slots that the character must spend on a particular
weapon or on a weapon specialization. CharSys gives the bonus slots but does not enforce the required

Creacing a Mulei€Classer Characeer

To create a multiclass character, you must first be in MultiClass Mode. Do this by clicking on the MultiClass
radio button. When you do this, you will notice several things happened. All the classes become checkboxes, all
the alignments and races are unselectable, the reroll button is unselectable, and the box around your ability scores
is gone. Basically, all you can do is select classes. Now, just click on the classes you wish your character to be.

If you choose a class that cannot be part of the multiclass, you will be told.
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You can select a deity by clicking on the Select Deity button. If your character is not a cleric, then you will see a
window like the first one above. If he is a cleric, then you will see a window like the second one above. If your
alignment is in red, then it does not meet the alignment requirement. When the Save button is enabled, then you
can select that deity.



Baving Your Characeer

Save
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Character Name |Jordan Malid

When you click on Save, a dialog box like the one above will appear. To save your character, type in your
character’s name and click Save. To delete a character, choose it from the listbox and click on Delete. Please note
that you must enter your name in the Player’s Name field before you can save.

Moving Rbilic)’ Bcores Around

Whenever you see your ability scores displayed and there is a box around them, you can move them around
using drag-and-drop. When you move your pointer over an ability score, it will become an opened hand. Just
click and hold the mouse button and drag the score and drop it on the ability (the number, not the name) where
you wish to place it. Those two numbers will then be swapped.
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CharSys features a very handy Info Mode. To use it, just click on the “i” button next to the alignment, race, or
class you want information on. The Info Mode is especially handy if you wish to choose a particular race or
class but can’t because it is unselectable. Info Mode should provide with the answers as to why. As for ability
scores, any printed in red are either too low or too high. You can move them around. See Moving Ability Scores

for information on how to do this.

Moving Rbility Bcores

You can move ability scores around using drag and drop. Whenever you see a box around your ability scores (no
matter which window you are in) you may move them. If you move your pointer over the box, it becomes a
hand. Just grab the ability score and drag it where you wish it to go and drop it. The ability score you are
moving will change places with the one you just dropped it on. This is very handy when you are trying to get
your ability scores to make the minimum requirements of the class you wish to choose.
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If you aren’t using Proficiencies (see Preferences) to choose languages, then you can select Edit Languages to
enter the languages your character speaks. To edit them, simply click on the line of your choice under Language
and type. Please note, that in order for the last item you entered to be saved, you must click on another line.



#diting Troficiencies

O - Edit Proficiencies ~ Jordan Malic
/ Non-Weapon Proficiencies \ / Weapon Proficiencies |
Available Proficiencies Ttasenl Your Current Proficiencies
Stekie Sword, Long(53
Sling
Spesr.short
StaffSling ——————
Stiletto | Specialize
Sword, Bastard, One<handed
Sword, Bastard, Two-handead
Sword, Broadsword Slots
Sword, Cuymore wm‘
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Sword, Machate
Sword, Mystic Sabre
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Learn |
Froficency | stots | Omeex : Boating
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LCanautags . TSRS
(save ]

This is where you learn proficiencies. To learn a proficiency, simply choose it from the left listbox and click on
Learn. You may “forget” proficiencies you have just learned. However, once you have saved your character, you
are stuck with them.

The Show popup menu in the Non-Weapon Proficiencies tab determines which non-weapon proficiencies to



show. If Allowed is selected, then only those proficiencies that your character is allowed to use will appear. If
Any is selected then all proficiencies in the database will appear.

The Weapon Proficiencies tab does not have a Show popup menu. However, it has a Specialize button. To
specialize in a weapon, you must first Learn it. The select it in the right listbox and click on Specialize.

A Bonus button has been added. This allows you to select a proficiency without it costing you any slots. Only
use this if your DM has given you permission to take a free proficiency. On your character sheet, all free
proficiencies will be marked with an asterisk.



Buping Lquipment
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i
This is where you can buy equipment for your character. To purchase something, click on the item in the left
listbox and then click on Buy. If you do not have enough money, the Buy button will be unselectable. If you do,
that item will appear in the right listbox. If you already have that item, then the quantity will increase When
purchasing something, your money is converted automatically. For example, Jordan wants to purchase a
“Gown, Common”, which costs 12 silver pieces. He only has 4 silver pieces. One electrum piece would
automatically be deducted, giving Jordan 14 silver pieces to make the purchase.

The Sell button allows you to change your mind of this edit session only. Once you have saved your character,
you cannot sell back any equipment

Weapons and Arwmor

If you have the Weapons/Armor Restrictions set (see Preferences), then you will get a list of weapons or armor
based on your class or classes. Further, if your character is a cleric, the weapons listed will be based on the
character’s chosen deity.
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This is where you edit your character’s physical attributes, ability scores, hit points, select armor worn, and
shield armor class modifier.

The plus/minus buttons will change the values of the edit fields they are beside. You can also enter a number
directly into a field. You will be told if the number you entered is out of range. The edit field to the right of the
Experience Points edit field is for adding and subtracting experience points. For example, if you entered 1000
and clicked on the “+” button, then 1,000 points would be added to your experience points.

Important - Be sure to save your character after each increase in experience level. Some races, classes, and/or
kits receive special abilities at certain levels. The only time this is checked is when you save your character.
Therefore, if you jump several levels and then save your character, you may miss an important ability! Also
every time you edit your character you will have to rechoose your shield AC modifier and armor worn.

Abanvoning a Kic

If the Abandon Kit button appears, then you have the option of abandoning your kit. However, once you do
that and save your character, you can NEVER get the kit back!
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[Save )
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B

This is where you edit your equipment. To add a piece of equipment, enter its name, its quanity, and select a
category. If you select Armor, then the Armor Class edit field will pop up. When finished, click on Add.

To edit a piece of equipment, click on it in the listbox. Make any changes you wish and click on Update.

If you wish to delete a piece of equipment, click on it in the listbox and click on delete.
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O Edit Money - Lytor
P 5010 5P
e (o ]| oo
e [

| cancel | | Save |

|
]

Converting GP to CP
1GP=100CP

Amount

|50

Cancel

[ Convert

With Edit Money, not only can you change the amounts you have by entering them in the edit fields, you can
also convert from one type to another by using drag and drop. When you move your pointer over a box, it
becomes an opened hand. You can now drag this to another money type and drop it (Note: Drag and drop does
not work directly over an edit field. Grab the box surrounding the edit field).

When you release the mouse button, you will see a window like the one above. You may convert any amount

you wish by changing the number in the edit field.




#Magic Vieapons
O EditMagic Weapons - lytor
Daggers? é

]
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Name |Dagger +1

Quanity |1 HitBonus (2~ Damage
Weapon Type

Crossbow, Light Quarrel
Dagger

Daggaer, Bone

Dagger, Parrying
Dagger, Stone

Dart

Flindbar

£ Bose. N SPNTR

So that magic weapons will print correctly in the Weapons Table on the character sheet, they have their own
editor. What you see above should be pretty much self-explanatory.

Weapon Type is very important. This determines what information is printed in the Weapons Table. Make sure
you set it correctly.
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O Edit Wizard Spells - Lytor
Avallable Spells Your Current Spells
Affect Normal Fires 757 Burning Hands
Alyrm Adds l Chill Tewch
Armor
Audsble G T
c‘":n: amer (:ﬂ‘!_ﬂt"l
Change Salf
Charm Parson
Shoewsora ([save |
Comprehend Languages™
Dancing Lights
hesLin = JETTT
Show | 1st Level - | Custom Spell Name [ I [
i

If your character can cast spells, this is where you edit them. To add a spell, select it from the left listbox and
click on Add. To delete a spell, click on it from the right listbox and click on Delete.

You can also add custom spells. Simply enter its name in the Custom Spell Name edit field and click on the Add
button to the right of it.



£0iting Thief Skills

0= - Edit Thief Skills - Thief =
Skill Assigned , Racial , DEX _ Total
Scores Adjust  Adjust Score
Pick Pockets 19 0 5 ]
Open Locks o & o 10 20
Find/Remove Traps 8 0 0 %
Move Silently o [ o 5 15
Hide In Shadows Sy ) e 5 10
Detect Noise 19 E] 0 0 19
Cimb Walls 0 [ o 0 60
Read Languages 0 m 0 0 0
Points Remaining 49
| Cancel | | save |

If your character can use thief skills, this is where you edit the scores. The Assigned Scores represent the total
of the character’s class’s base scores and assigned scores. To change the numbers, click on the plus or minus
buttons.

If both the plus and minus buttons are unselectable then you cannot use that skill.



Selecting a Portrait
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| Fignters [ &1
Current Preview

& ' Female Wereranger_01. '
¥ Female_Wereranger_02,
Male_Albino_Fighterjpg
Male_Dragonlord 01,jpg 3
Male_Dragonlord 02jpg
Male _Dragonlord 03jpg
Male Dragonlord O4.jpg
Male Fighter 01.jpg
Male Fighter 02jpg
Male_Fighter_03)pg

| save | [ Desktop | Open

4]

You can select a portrait for your character in one of several different ways.

To choose your portrait from a file, simply navigate to the file using the file navigation listbox and popup menu
in the center of the window. As you move across each picture, an image will appear in the Preview box. To
select a portrait, click Open.

You can also copy an image from a graphics editing application and paste it into this window. Doing so will
replace the picture in the Current box.

You may also drag a picture onto the Current box. You can also drag the picture from either the Current or
Preview box and drop it onto a graphics editing application.

When finished, click Save.
Obcaining Poreraices

There are a few ways to obtain pre-formatted portraits for CharSys. The first is by downloading the portraits
file on the charsys.com website. These are very small portraits that were developed for versions 3.1 and below
before a larger size allocation was developed.

You could also visit the CharSys Worlds Exchange to obtain a collection of files or individual portraits from the
Portrait Archive ce it is designed. Here you will be able to not only download portraits, but submit portraits of
your own to share with other CharSys Users.


http://cswe.charsys.com/
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0= — ~ EditNotes - Beastmaster =] =]
Born of noble birth, bad

‘]

[ cancet | | Save |

=

Notes are sort of a catch-all. Basically, anything you wish to be known about your character not already covered
in CharSys should be entered here. Please note, that Notes are only displayed on the hard copy of your
character sheet.



Tarties

Creacing Parcies

O : Create Party =
PartyName | jordans Party |
World | ADZD |

In CharSys, you can group your characters into Parties. Why would you want to do this? Because you can
easily distribute money and experience points among the members of a party without having to edit each one
individually. Of course, anything else you wish to do with a party member must be done individually.

The first step is to create a party. Do this by selecting Tools>Parties>Create.

Just type in the name of the party, select the world it belongs to, and click on Create. Keep in mind that you
cannot have more than one party of the same name.

Evicing Parcies

To edit a party, select Tools>Parties>Edit. A dialog box will appear asking you to select the party you wish to
work with. Make your choice and you will see a window like this:

O Edit Party - Jordans Group =

/ Add/Remove \/ Distribute \

Avallable Members to Add to Party Current Party Members

Drakaar Conjurer

Forest Runner Human Cleric

Jordan Litanium
Lytor ‘(Remove<| |Paladin
= (<Removec]

Ranger
Test2
Text

Unknown

14>
lcii

Sivve

The first tab is where you can add members to your party or remove members from it. To add a member,
simply choose him from the left listbox and click add. To remove a member, choose him from the right listbox



and click remove. Please note that only those characters belonging to the same world as the party will be
selectable.

O Edit Party - Jordans Group =]
/ Add/Remove v Dlstrthute\
Members Distribution List
Human Cleric ok vAdd, Member ]ExpL $
L Paladin 5% Even |-
cRemovec| | Conjurer All  Even |~
Litanium All  Even
| Experience [1000 | [5% - |
-| Money [ 10000 i[de_~| [Even ~|
Distribution Status: Waiting
—

This is where you will do most of your work with parties. The left listbox contains all the members of the
party. The Distribution List contains all the members of your party you wish to distribute money and/or
experience points to. You will notice that there is an Exp column and a $ column in the Distribution List. These
determine how Experience Points and Money will be distributed in the following fashion:

All = The member will receive all the Experience Points and/or Money you have entered (example: in the above
picture, both Conjurer and Litanium would receive 1000 experience points each).

Even = The members of the party would receive an equal share of Experience Points and/or Money. (example:
in the above picture, Conjurer and Litanium would share the 2000 CP so they would get 1000 CP each).

% = If a percentage is displayed, then the member would receive that percentage of the Experience and/or
Money.

To select which option you wish to use, click on the member in the Distribution List, then set the popup menus
beside Experience and Money to those of your choice.

When you click on Distribute, there may be a long delay depending on how many members you have in your
Distribution List. Each member’s experience points, levels, and hit points will be adjusted and saved.



Fnput a Character

o InputCharacter  H
Alignment | Lawful Good | Cass1 | Abjurer - |

Race | Dwarf v | Qass2 |None |

Kit | None v] Qass3 [None [+

Deity | None ~]  sex [Male ~]

Make your initial choices from the pop-up menus above. This will get
your character started, After you save it, use the tools to complete
your character.

[Cancet] | sove | Player Name | |

With CharSys you can easily input a character you already have on paper. All you need to get started is to enter
the information pictured above. After that, just go to the various Tools and edit your character.

If you have the Create/Input Guide turned on, you will be guided as to what the next steps might be to complete
your character.



A00s & £Hnds

Toolbar Funceions

O Tools: B

If you have the tool tips feature turned off, or even if you don’t may be wondering what each of the buttons on
the toolbar are for and how they function. This section will give you a quick rundown on what each buttons
function is and what section of this manual pertains to it (if any):

A) Open = Opens an already saved character.
B) Save = Saves current character.
C) Print = Prints the character sheet that is currently open.

D) Export Character = Exports the character sheet that is currently open. A variety of options are available
for export. See for Exporting a Character more information.

E) Edit Languages = Allows user to enter languages the PC can speak. Will be greyed out if the proficiency
preference is checked. See Editing Languages for more information.

F) Edit Proficiencies = Allows the user to choose the PCs proficiencies. See Editing Proficiencies for more



information.

G) Buy Equipment = Allows the user to buy equipment, weapons, and goods for their PC. See Buying
Equipment for more information.

H) Edit Character = Allows the user to do many things such as choose worn armor, etc. See Editing Your
Character for more information.

I) Edit Equipment = Allows the user to add equipment that was found, not bought. See Editing Equipment for
more information.

J) Edit Money = Allows the user to edit the coin his character owns. See Editing Money for more information.

K) Edit Magic Weapons = Allows the user to enter magical items that the PC may acquire. See Magic
Weapons for more information.

L) Edit Thief Skills = Allows the user to adjust his PCs thieving skills. If the PC doesn’t have thieving skills
this button will be greyed out. See Editing Thief Skills for more information.

M) Edit Wizard Spells = Allows the user to choose what wizard spells his PC knows if applicable. If the PC
doesn’t have wizard spell access this button will be greyed out. See Editing Wizard/Priest Spells for more
information.

N) Edit Priest Spells = Same as above except for priest spells. If the PC doesn’t have priest spell access this
button will be greyed out.

O) Select Portrait = Allows the user to choose a portrait for his PC. See Selecting a Portrait for more
information.

P) Edit Notes = Allows the user to input notes about his PC. See Editing Notes for more information.

Q) Edit Parties = Allows the user (mainly DMs) to administer gaming parties. See Parties for more
information.

R) Input Character = Allows the user to quickly input a pre-rolled character into CharSys. See Input a
Character for more information.



Regiseering Cﬁarsys

O Registration =

Name [l’lovd Resler ]

Organization |Data Dimensions Software |

Email llresler@(harsys.(om ]

Ifyou would like to make any comments
that others can see on the Web, enter
them below.

Piease Registery

| Cancel | |Save & Close| |Save &Send |

Iz

You can register CharSys by selecting Register from the Apple Menu. Make sure you fill in all the fields (you
can leave comments blank if you wish). If you wish to go ahead a register on-line, click on Save & Send. This
will contact the CharSys Web site and save your registration. If you do not wish to send your registration, click
on Save & Close. If you wish to register on-line later, you may do so either via CharSys or going to the Web

Wﬁy Regiseer

You may be asking, CharSys is FREEWARE! Why should I register it? Well there are two simple reasons. The
most important is so that we may keep track of how many people are using our product. If there aren’t many
people using it then updates will be few and far between, or even non-existent. Programming a program such as
this takes many man-hours and we want to make sure that the work isn’t in vain. The second reason is to get rid
of that pesky UNREGISTERED watermark on the character sheets that you print. This was done to try and
“nudge” people into registering the product. So, if you like CharSys and would like to see it updated and
expanded please register.

Idle




Poferare Upvaces

Software Updates

Your version: 3.2.1

Current Version: 3.0.3

| Download | | Cancel

Connected

You can find out what the latest version of CharSys is by selecting Updates from the File Menu. This will
require an active Internet session. After a few seconds, you will be shown the newest version of CharSys. If you
wish to download it, click on Download.

Exporcing a Characeer

CharSys keeps all characters in one file. That could create a problem if you wish to copy a character to a
friend’s copy of CharSys. This is where Export comes in. You can find it in the File Menu (or on the CharSys
Toolbar). To use it, first open the character you wish to export and then select Export. You can export your
character in CharSys format, text format, Palm Pilot, or HTML. Please note that a Palm Pilot version of
CharSys is in the works but has not been completed.

Tmporeing a Characeer

You can import a character that was exported by CharSys. This is handy for sharing characters with your
friends. To do this, just select Import from the File Menu and select the file. That character will be added to
your hero database.

Uploaving a Characeer

You can upload your character to the on-line database. This will allow you to show (off) your character on-line
and share it with others. To do this, you will need a live Internet connection and you will need to be a
registered user.



To upload a character, first open it in CharSys and then select Upload Character from the File Menu. After a
few moments, you will get one of three results:

Upload Character

This will upload your character to the
CharSys Hall of Fame.

Sorry, Jordan Malicis a characteralready entered by
Steve Crump.

Cancel

If you see the above, then the character you are trying to upload is taken by someone else.

Upload Character

This will upload your character to the
CharSys Hall of Fame.

Character Avatar does notexistand you are free to
uploadit,

Email: fresler@charsys.com

If you see the above, then the character does not exist on-line and you are free to upload it. Please note that
there is more to this window as detailed below.

Upload Character

This will upload your character to the
CharSys Hall of Fame,

‘CharacterJordan Malicalready exists, Click on update if
vou wish to update your characten,

Email: |[ffresler@charsys.com

If you see the above, then the character already exists, but you are free to modify it. Please note that there is
more to this window as detailed on the next page.



Enterany backaround information beiow that you would
like otherstosee whenthey are view your charactaronthe

Web,

Eventhough Jordanis ofnoble birth, he enjoys
hanging around with his peasantfriends, Lytor (an
aspiring wizard) and Bradford, a dwarf. =

[ Allow others to download this character

You canalso allow others to modify your characterand
upload it. Entertheir names in the fields below, seperated
by commas. Ifyouwish this feature disabled; leave the field
blank. Ifyou wish ahyone to be able to modify your
character, enter "All".

Nitehawk Jarrett,Tony Bounds

]

This is the remainder of the dialog box you will see if you can upload your character.

Always make sure your email address is correct. If you wish, you may enter some background information

about your character that will be displayed on-line.

If you wish to allow others to download your character, check the Allow others to download this character
checkbox.

You can always modify your own character. However, you can allow others to modify it as well. Just follow

the on-screen instructions.

Poxynloaving a Characeer

I=——— bownhadl=————————HIH

Selectthe character you would like to download.

Characten I Race I Class |Lev_e|l World I twner lRevisionsI
Jordan Malic Human Fighter T ADDCore Floyd Resler 2

<]

[ cancel |  [Download| '_1




You can download characters from the on-line database. To do this, you will need a live Internet connection and
you will need to be a registered user.

To use this option, select Download Character from the File Menu. After a few moments, a window like the one
above will appear.

Just select the character you wish to download and click Download. You will then be presented with the
CharSys save dialog box. The Revisions column tells you how many times the character has been revised.

Uploading and Download is a great way to share characters and to brag about them as well!

Themes & Cﬁarﬁys

Undo 3#k7

Cut X

Copy 3#EC

Paste HY

Clear

Preferences... 3;

Blue Paper
v Classic Platinum

Denim
Dungeon Wall
Gray Paper
Icon
Parchment
White Marble
Yellow Paper

One new feature of CharSys 4 is the ability to choose different themes. To do this go to Edit>Select Theme.
There (if you have themes installed) you will see a list of the themes available for CharSys. Themes for CharSys
are not like those that you may be familiar with. They do not change the entire GUI of the application. Rather
they just add a background pattern into the application windows.

3 You can also create themes of your own if you find none of the pre-installed ones to your liking. To do
m that you will need CharSys ThemeBuilder which can be found at the Web site.

Hivven Becree of CﬁarSyB

For those of you that enjoy programs with Easter Egg’s then you are in for a treat. CharSys has an
h Easter Egg of it’s own at the request of it’s art director, Nitehawk Jarrett. Since easter egg hunters
¢ are known for enjoying the hunt we won’t give away it’s location. We will give a slight hint
though...it has something to do with the command key. Happy Hunting!




Eonclusion

Thanks for using CharSys. CharSys is a true labor of love for both myself (Floyd Resler) and the art director,
Nitehawk Jarrett. Neither of us will ever see any money for our efforts since releasing CharSys as shareware
would violate Wizards of the Coast’s copyrights and thus force CharSys to be removed from the market.

Our biggest satisfaction is that people use CharSys and enjoy it. And our goal is simple - to have the best
AD&D utility software available on any platform!

Please note that CharSys d20 is now in development. It is unclear as to when this will be ready for a public
release, but if you are interested in becoming a beta tester for it please contact Floyd Resler at
fresler(@charsys.com for information.

Enjoy!


mailto:fresler@charsys.com?subject=BetaTester Info
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